6D HP LaserJet 2300DTN Black and White Printer

6D.1 Overview

This appendix is designed to provide maintainers with the information necessary to support the HP LaserJet 2300DTN Printer.  This appendix identifies the printer’s Line Replaceable Units (LRUs) as well as the LRU controls and indicators.

The OASIS equipment includes either an HP LaserJet 4100TN or an HP LaserJet 2300DTN Black and White (B/W) Printer, which support the AFSS Workstations.  The HP LaserJet 2300DTN comes standard with 64 MB RAM and an Ethernet Network Card for connecting to a network.  For further information regarding the 2300DTN printer XE "Color Printer" , refer to the LaserJet 2300DTN Black and White Printer User Manual.

The LaserJet 2300DTN Black and White Printer is shown in Figure 6D-1
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Figure 6D- 1.  HP LaserJet 2300DTN Printer

6D.2 HP LaserJet 2300DTN Printer LRUs

The 2300DTN Printer contains two LRUs.  The first is the Printer itself.  The second LRU is the Ethernet Network Card, which provides a 10B-T/RJ-45 interface to the LCN.  The 2300DTN Printer LRUs and consumables are described in Table 6D-1.

Table 6D‑1. HP LaserJet 2300DTN Printer LRUs and Consumables

	Item
	Description
	Part Number

	B/W Printer
	HP LaserJet 2300DTN Printer
	C8051A

	Toner Cartridge
	Toner Cartridge
	C4127A


6D.3 HP LaserJet 2300DTN HP Printer Controls and Indicators

6D.3.1 Controls and Indicators

	
	The LED Display is used to display Printer messages.  Due to the volume of possible Printer messages, they are not listed within this manual.  Most of the messages are self-explanatory, but if a message is difficult to understand, refer to the HP Printers User’s Guide for the HP LaserJet 2300DTN Printer for an interpretation.  
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Figure 6D‑2.  2300DTN  B/W Laser Printer Control Panel Controls and Indicators

Table 6D‑2.  2300DTN B/W Laser Printer Control Panel Controls and Indicators

	Item Number
	Description
	Function

	1
	Graphical Display
	Displays menus, messages and information

	2
	Up Button
	Navigates to the previous item in the list, or increases the value of items that are numerical in nature

	3
	Select Button
	Opens menus and navigates through menu levels

Clears an error condition when the condition is clearable

Saves the selected value for an item

Performs the action associated with the item that is highlighted on the graphical display

	4
	Down Button
	Navigates to the next item in the list, or decreases the value of items that are numerical in nature

	5
	Cancel Job Button
	Cancels the current print job in process and expels all active pages from the paper path.  The time that it takes to cancel the job depends on the size of the print job.  (Press the button only once.)

NOTE:  The control panel lights while the print job is cleared from both the printer and the computer, and then return to the ready state (Ready light on)

	6
	Attention Light
	The printer has experienced a problem. Note the message on the control panel display, and then turn the printer off and then on again. (See the information in the use guide about interpreting the messages on the control panel for help in resolving problems.)

	7
	Data Light
	The printer has data to print, but it is waiting to receive all of the data.

	8
	Ready Light
	The printer is online and ready to accept data to print

	9
	Pause/Resume button
	Pause:  Causes the printer to stop printing the current job and expel all active pages from the paper path

Resume:  Returns the printer to the ready or busy state from the menus or the online Help

	10
	Back Button
	Backs up one level in the menu tree or backs up one numeric entry

Exits menus if held down form more than one second

	11
	Help Button
	Provides information about the message on the graphical display


6D.3.2 Setup/Configuration

The 2300DTN Printer configuration and setup parameters can be set or changed through the Control Panel Menu.  A Menu Map can be printed from the Control Panel, showing the available menus and items.  A Configuration Page can also be printed showing the printer’s current setup and configuration.

6D.3.2.1 Using the printer Help system 

This printer features a Help system at the control panel that provides instructions for resolving most printer errors. 

To view Help for a message (if available), <Press> [image: image3.png]


 (Help button). If the Help topic is longer than two lines,<Press> ( (Up button) and ( (Down button) to scroll through the entire topic. 

To exit the Help system, <Press> [image: image4.png]


 (Help button) to scroll through the entire topic. 

6D.3.2.2 Printing control panel menus 

To see the current settings for the menus and items available at the control panel, print a control panel menu map. Store the menu map near the printer for reference. 
Use the following steps to print a control panel menu map. 

1.
<Press> ( (Select) to open the menus. 

2.
<Press> ( (Up button) or ( (Down button) to scroll to INFORMATION, and then press ( (Select). 

3.
<Press> ( (Up button) or ( (Down button) to scroll to PRINT MENU MAP, and then <Press> ( (Select). 

6D.3.2.3 To Print a Configuration Page 

Use the following steps to change a control panel setting. 

1.
<Press>( (Select) to open the menus. 

2.
<Press> ( (Up button) or ( (Down button) to scroll to INFORMATION, and then <Press> ( (Select). 

3.
<Press>  ( (Up button) or ( (Down button) to scroll to the PRINT Configuration setting, and then <Press>  ( (Select). 

NOTE: Printer-driver settings override control panel settings. Software program settings override both printer-driver settings and control panel settings.  If it is not possible to gain access to a menu or item, it is either not an option for the printer, or the associated higher-level option has not been enabled.  

6D.3.2.4 To set the IP Address for Network communications:

The OASIS equipment uses common IP addressing schemes from site to site.  The first 3 fields of an IP Address represent a Site ID, and the last field is used to designate a specific piece of site equipment.  The IP Address and Hostname for the 2300DTN Printer are designated as follows:

· IP Address  - xxx.xxx.xxx. 12, where the x’s represents a Site ID.

Print a Configuration Page to check the IP Address of the 2300DTN Printer.  Refer to Appendix A for specific site and equipment IP address information.

1.
<Press> Select Button.

2.
<Press>  (  to scroll down to CONFIGURE DEVICE
3.
<Press> Select Button

4.
<Press>  (  to scroll down to I/O

5.
<Press> Select Button
6.
<Press>  (  to scroll down to EIO 1 JETDIRECT MENU

7.
<Press> Select Button
8.
<Press> (  or  (  to scroll up to TCP/IP

9.
<Press>  (  to scroll down to MANUAL SETTINGS

10.
<Press> Select Button
11.
<Press> (  or  (  to scroll to IP ADDRESS

12.
<Press> Select Button
13.
<Press> (  or  (- to change IP Byte 1 to xxx  (where xxx = first octet of site IP)

14.
<Press> Select Button.  The second group of numbers will be highlighted.

15.
<Press>  (  or  (- to change IP Byte 2 to xxx   (where xxx = second octet of site IP)

16.
<Press> Select Button.  The third group of numbers will be highlighted.

17.
<Press>  (  or  (-to change IP Byte 3 to xxx   (where xxx = third octet of site IP)

18.
<Press> Select Button.  The final group of numbers will be highlighted.

19.
<Press> (  or  (-to change IP Byte 4 to 12
20.
<Press> Select
21.
<Press>  Pause/Resume button to return to the main menu

6D.3.2.5 To Verify the IP Address and Network Communications:

1.
At the Backup NT Server uses the Start button to <Select> Start>Programs>Accessories>Command Prompt to open a DOS Window.

2.
At the prompt, <Type> ping(xx.xxx.xxx.12

The system should reply a number of times with the correct IP Address.  If the system responds with a “timeout”, recheck the IP Address and the Network connections.

3.
Print a “Configuration Page” to verify the IP Address, if necessary.

6D.3.3  XE "Maintenance" Maintenance Procedures

6D.3.3.1 To continue printing when Toner is low:

The Printer will display “Order Cartridge” message on the LED Display when the toner cartridge has 10% of its toner remaining.  The default is for the printer to keep printing until the toner runs out.  When the toner cartridge is completely empty, a display message of “Replace Cartridge” will appear and all activity will stop.

1.
To resume printing, <Press> the Pause/Resume button.

2.
To load in a new cartridge use the “Remove and Replace the Toner Cartridge” procedure.

NOTE: Removing the Toner Cartridge and rotating and gently shaking the cartridge to redistribute the toner can sometimes temporarily improve the print quality.  When finished, reinstall the cartridge and check the print quality.

6D.3.3.2 To clean the Printer:

To maintain print quality, clean the Printer whenever the Toner Cartridge is replaced or when print quality problems occur.

1.
Turn the printer off and unplug the power cord.

2.
Open the top cover and remove the toner cartridge.
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WARNING:  Avoid reaching too far into the printer.  The adjacent fusing area might be hot.

CAUTION:  To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.

3.
Wipe any dust or dirt off the paper feed guides with a dry, lint-free cloth.

NOTE:  If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. (Hot water sets toner into fabric.)

4.
Using the green handle, lift the paper access plate and wipe off any residue with a dry, lint-free cloth.

5.
Reinstall the toner cartridge, close the top cover, plug the power cord in, and turn the printer on.

6D.3.3.3 To clean the Fuser:

Run the Printer Cleaning page to keep the fuser free of toner and paper particles that can sometimes accumulate.  Accumulation of toner and particles can cause specks to appear on the front or backside of your print.

To ensure optimum print quality, it is recommended that you use the Cleaning Page every time you replace the toner cartridge or automatically on a set schedule.

You can run a cleaning page in two ways:

· Manually as needed from the printer control panel.

· Automatically according to an interval that you set

The cleaning procedure takes about 2.5 minutes to complete\

Running the Cleaning Page Manually

NOTE:  In order for the cleaning page to work properly, print the page on copier grade paper (not bond, heavy, or rough paper).

To run the cleaning page manually, perform the following procedure:

1.
At the printer control panel, <Press> Select   to open the menus.

2.
<Press> ( (Up button) or ( (Down button) to scroll to Configure Device, and then <Press> ( (Select)..

3.
<Press> ( (Up button) or ( (Down button) to scroll to Print Quality, and then <Press> ( (Select).

4.
<Press> ( (Up button) or ( (Down button) to scroll to Create a Cleaning Page, and then <Press> ( (Select)

5.
Follow the directions on the cleaning page to finish the procedure

Remove and Replace Procedures

	  See Another Document
	For the interconnect information on LRUs, use the OASIS Site Drawing Package for your location.


6D.3.3.4 To remove and replace the Toner Cartridge:

1.
Open the printer by lifting the top cover.

2.
Remove the used Toner Cartridge from the Printer by grasping it and pulling it up and out.  Then discard.

3.
Remove the new Toner Cartridge from its packaging (save package for possible cartridge storing), and rotate the Cartridge and gently shake it from side to side to distribute the toner evenly inside the Cartridge.

CAUTION:  To prevent damage to the Toner Cartridge, do not expose it to light for more than a few minutes.
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Figure 6D‑3.  Install or Replace the Toner Cartridge

4.
Locate the sealing tape tab on the end of the Cartridge.  Carefully bend the tab back and forth until it separates from the Cartridge.  Firmly pull the tab straight out from the Cartridge to remove the entire length of tape (22 inches).  Avoid touching any black toner on the tape.

NOTE:  If the tab separates from the tape, grasp the tape and pull it out of the Cartridge.

5.
Position the new Cartridge with the arrow pointing toward the Printer and reinsert it into the Printer.  If the Cartridge is installed correctly, the cover will close easily.

NOTE:  If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water (hot water will set the toner into the fabric).

6D.3.3.5 To remove and replace 2300DTN Printer

1.
Power off the Printer

2.
Remove all cables from the rear of the unit.

3.
Remove the paper and Toner Cartridge and set it aside.

CAUTION:  To prevent damage to the Toner Cartridge, do not expose it to light for more than a few minutes.
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WARNING:  The 2300DTN Printer unit weighs approximately 46 lbs.  Removing the Printer requires a two-person lift.

4.
Remove the faulty Printer and set it aside.

5.
Unpack the replacement Printer, saving the packing material to return the faulty Printer to the Depot.

6.
Check to see if the replacement Printer contains an Ethernet Network Card.  If not, remove the Network Card from the old Printer and install it into the new Printer, using the Remove and Replace the Ethernet Network Card Procedure.

7.
Assemble the Printer and install the paper and Toner Cartridge.

CAUTION:  Ensure that the Printer is turned Off before connecting the Ethernet Cable to the RJ-45 port.

8.
Connect all removed cables to the new Printer.

9.
Power on the new Printer.

10.
Print a Configuration Page and check the IP Address of the 2300DTN Printer.

6D.3.4 Testing/Verification

Operational Verification

To ensure that the Printer is operational, print a Configuration Page.  

 XE "Fault Isolation" Fault Isolation Checklist

· If toner specks appear on the front or back side of your print jobs, perform the “To Use the Print Cleaning Page Function” procedure from the 2300DTN Printer Control Panel.

· If experiencing a print quality problem, change the Toner Cartridge and perform the “Clean the Printer” procedure.  If the print quality problem continues, call the Harris Help Desk.

· If frequent paper jams occur, call the Harris Help Desk prior to removing and replacing the Printer.

· Print a Configuration Page to ensure that the 2300DTN Printer is functioning properly.  If the 2300DTN Printer will not print a configuration page, call the Harris Help Desk prior to removing and replacing the Printer.

· Login to WINGS and print a Weather Data List through the List menu to verify that the 2300DTN Printer will print using the network.

· If the Printer will print a Configuration Page but will not print using the network, suspect the Ethernet Port, Ethernet Cable or Printer Network Card.  Check the Ethernet connections between the Ethernet Switch and the Printer Network Card.

· To further isolate, ping the 2300DTN Printer from the Maintenance Position.  If the Printer can be pinged, the Printer’s Network Card, Ethernet Cable and the corresponding Ethernet Port are likely operational.

· Use the Site Drawing Package to identify the Network cables and the Printer port on the Ethernet Switch.  Check the port for a Link (green) indication and ensure that the port is operating at 10 Mbps.

· If the Printer does not have connectivity to the LCN (a Link indication), go to the Ethernet Switch and identify the cable of a operational WS or printer (one where the Link light is ON), that is not currently being used and unplug the cable from its port.  Swap the cable of the 2300DTN Printer (Link light is OFF) from it's port to the port of the known good WS or Printer.

· If the Link and the 10 Mbps indicators are ON at the new port, suspect the Ethernet Switch.  Power the Switch Off and then On, and verify the configuration of the problem port prior to removing and replacing the Ethernet Switch.

· Return the Switch connections to their original positions.

· If the indicators continue to have a problem in the new port, suspect the Ethernet Cable or the Printer Network Card.

· At the Patch Panel in the back of Rack 101, use the corresponding ports for the known good Workstation or Printer and the 2300DTN Printer to further isolate the connection problem to the specific cable or to the Printer Network Card.

· Upon isolation replace or re-terminate the suspect Ethernet Cable or remove and replace the Printer Network Card.

Testing Procedures

6D.3.4.1 To “ping” the 2300DTN Printer:

To check the Ethernet Port and the cable to the 2300DTN Printer, ping the 2300DTN Printer from the Maintenance Position.

1.
At the Maintenance Position (NT Server 2), <Click> the Start button and select Start>Programs>Accessories>Command Prompt to open the Command Prompt dialog box.

2.
At the prompt, <Type> ping(xxx.xxx.xx.12 (where the x’s represents the Site ID and .12 is the 2300 DTN printer IP address) to ping the 2300 DTN Printer.


If the Ethernet Port and the connection to the device under test are operational., the system should respond three times with the correct IP Address and the number of bytes transferred.


If the system responds with a “timeout”, recheck the device’s IP address and the network connections.

3.
Upon the completion of using the Command Prompt window,  <Type> exit at the prompt to return to the Windows Desktop.

6D.3.4.2 To test the 2300DTN Printer using the Network:

To check the operation of the Printer through the Network, print a text file from an AFSS Workstation.

1.
Ensure that the Printer is ON and that the “READY” message is displayed on the control panel. 

2.
At an AFSS Workstation, if necessary, login to the WINGS application as follows:

a.
<Double-click> the WINGS icon and login using the appropriate Username and Password.

b.
At the Functional Assignment Selection dialog box, <Select> an appropriate Functional Assignment from the list and <Click> the OK button.

3.
When the WINGS window is displayed, <Click> on the List menu and <Select> Weather Data to display the Wx Data List dialog box.

4.
When the Wx Data List dialog box is displayed <Click> on the File menu and <Select> Print to display the Print dialog box.

5.
Within the Print dialog box, <Click> on the  (down arrow) of the Name drop-down list box and <Select> mprinter to choose the HP LaserJet 2300DTN Printer.

6.
With mprinter as the selected printer <Click> the OK button to print the Wx Data List to the 2300DTN Printer.

7.
Ensure that the WX Data List was printed to verify that the 2300DTN Printer is operational through the LCN.
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